The Basics of Microsoft Excel

Theresa A Scott, MS
Biostatistician III
Department of Biostatistics
Vanderbilt University

theresa.scott@vanderbilt.edu
# Table of Contents

1 Introduction .................................................. 1
   1.1 Spreadsheet Basics ...................................... 1
   1.2 Screen Elements .......................................... 2
   1.3 Data Selection ........................................... 2
   1.4 Spreadsheet Navigation ................................... 3

2 Data Entry and Revision ...................................... 4
   2.1 Cut, Copy, and Paste ...................................... 5
   2.2 Find and Replace ........................................... 5
   2.3 Filling Data ............................................... 6
   2.4 Sorting Data ............................................... 6

3 Formatting Cells ............................................. 7
   3.1 Format Cells dialog box ................................... 7
   3.2 Autoformat ................................................ 8
   3.3 Format Painter ............................................. 8
   3.4 Formatting Toolbar ....................................... 8
   3.5 Conditional Formatting .................................. 8
   3.6 Styles .................................................... 10

4 Other Useful Skills .......................................... 11
   4.1 Additional Keyboard Shortcuts ............................ 11
   4.2 Worksheet Modification ................................... 11
   4.3 Page Properties and Printing ............................. 12
   4.4 Data Import and Export .................................. 13
       4.4.1 Importing Data ........................................ 14
       4.4.2 Exporting Data ........................................ 15
   4.5 Customizing Excel ........................................ 15
       4.5.1 Menus ................................................... 15
       4.5.2 Toolbars ................................................ 15
Preface

All of the lecture notes and supplementary sample data files are located at http://biostat.mc.vanderbilt.edu/TheresaScott under Current Teaching Material.

If you have any questions, feel free to contact me at theresa.scott@vanderbilt.edu or (615) 343-1713, or drop by my office D-2217 MCN.

References for this lecture

The following references were used to compile this lecture:

- The Excel 2003 Module information available from Carnegie Mellon University’s Computer Skills Workshop Class (www.cmu.edu/computing/csw)
- The BayCon Group Microsoft Excel Online Tutorial (www.baycongroup.com/e10.htm)
- The Florida Gulf Coast University Excel 2000 Tutorial (www.fgcu.edu/support/office2000/excel)
Section 1

Introduction

Microsoft Excel is an electronic spreadsheet application.

- A spreadsheet is the computer equivalent of a paper ledger sheet.

Microsoft Excel can be used to organize, calculate, and analyze your data.

- Unlike manual systems, your spreadsheet environment can become a responsive and dynamic work environment by using formulas, which will automatically update when you change your data.

Microsoft Excel enables you to (among countless other things):

- format your data;
- organize your data by sorting it;
- name ranges of data and use the range names in formulas and navigation for automatic updating;
- use cell references rather than values in formulas allowing you to adjust formulas as you copy and move them across the spreadsheet;
- generate charts and graphs illustrating your data;
- automate and customize procedures by using macros.

An introduction to all of these mentioned tasks will be covered in the four Introduction to Excel lectures.

1.1 Spreadsheet Basics

- Each Excel file is a workbook that can hold many worksheets.
- Each worksheet (i.e. spreadsheet) is made up of
  - rows (horizontal; designated by numbers),
  - columns (vertical; designated by letters),
  - and their intersections, which are called cells.
- The letters and numbers of the columns and rows (called labels) are displayed in gray buttons across the top and left side of the worksheet.
- Each cell on the spreadsheet has a cell address that is the column letter followed by the row number.
– Example: the very first cell address in the worksheet is A1 (column A, row 1).

- There are three basic types of data that can be entered into a cell:
  1. text (text with no numerical values, such as "Days"),
  2. numbers (just a number/a constant value, such as "5"),
  3. and formulas (a mathematical equation used to calculate a result, such as "+5+3")

- NOTE: All formulas MUST begin with an equal sign (=) in order to be calculated.

1.2 Screen Elements

The following are elements of the Microsoft Excel environment:

- **Menu bar**: displays the names of the drop-down menus; contains the minimize, maximize, and close buttons for the document.
- **Toolbars**: provide shortcuts to menu commands (Standard and Formatting toolbars shown by default).
- **Cell Number Box**: displays the address of the active cell.
- **Formula Bar**: displays the contents of the active cell.
- **Worksheet Tabs**: show the worksheet or chart names; new files have three worksheet tabs by default.
- **Scroll Bars**: navigates to different areas of the active worksheet; located on the right and bottom of the worksheet.
- **Worksheet Tab Scroll Buttons**: scrolls the display of sheet tabs one at a time or to display the first and last grouping of sheet tabs.

1.3 Data Selection

Use the mouse and/or keyboard shortcuts to select (highlight) cell(s), row(s), and column(s) of data:

- Single clicking on the column label will highlight the whole column.
- Single clicking on the row label will highlight the whole row.
- Clicking and dragging across several row or column labels will highlight several rows or columns, respectively.
- Clicking and dragging across a group of cells will highlight the contiguous (adjacent) group.
- Single clicking on one cell, pressing the F8 key (once) or holding down the Shift key, and then using the arrow keys to select the contiguous group will also highlight them.

  - With the F8 key, you must press the F8 key once again or press the Escape key once to escape from the highlighting.

- **Noncontiguous** (non-adjacent) cells can be highlighted by holding down the Ctrl key and using the mouse to single click the desired cells.
- Clicking on the gray box where the row labels and column labels intersect (top left corner of worksheet) will highlight the whole worksheet.

- Other keyboard shortcuts for selecting cells include:

<table>
<thead>
<tr>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+Spacebar</td>
<td>Highlight the entire column</td>
</tr>
<tr>
<td>Shift+Spacebar</td>
<td>Highlight the entire row</td>
</tr>
<tr>
<td>Ctrl+A</td>
<td>Highlight the entire worksheet</td>
</tr>
</tbody>
</table>
### 1.4 Spreadsheet Navigation

As you enter and edit data, you will need to move through the worksheet, which can be done using your mouse or keyboard shortcuts.

The following is a summary of available spreadsheet navigation techniques:

<table>
<thead>
<tr>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single Click Cell</td>
<td>Makes the cell active</td>
</tr>
<tr>
<td>Enter</td>
<td>Moves the active cell one cell down</td>
</tr>
<tr>
<td>Shift+Enter</td>
<td>Moves the active cell one cell up</td>
</tr>
<tr>
<td>Tab</td>
<td>Moves the active cell one cell to the right</td>
</tr>
<tr>
<td>Shift+Tab</td>
<td>Moves the active cell one cell to the left</td>
</tr>
<tr>
<td>↑</td>
<td>Moves the active cell up one row</td>
</tr>
<tr>
<td>↓</td>
<td>Moves the active cell down one row</td>
</tr>
<tr>
<td>←</td>
<td>Moves the active cell left one column</td>
</tr>
<tr>
<td>→</td>
<td>Moves the active cell right one column</td>
</tr>
<tr>
<td>Home</td>
<td>Moves the active cell to column A of the current row</td>
</tr>
<tr>
<td>Ctrl+Home</td>
<td>Moves the active cell to A1</td>
</tr>
<tr>
<td>Ctrl+End</td>
<td>Moves the active cell to the last cell in the spreadsheet with data</td>
</tr>
<tr>
<td>Page Up or Page Down</td>
<td>Moves the active cell up or down by one screen full of rows</td>
</tr>
<tr>
<td>Ctrl+↑</td>
<td>Moves the active cell to the first row with data in the current column</td>
</tr>
<tr>
<td>Ctrl+↓</td>
<td>Moves the active cell to the last row with data in the current column</td>
</tr>
<tr>
<td>Ctrl+←</td>
<td>Moves the active cell to the first column with data in the current row</td>
</tr>
<tr>
<td>Ctrl+→</td>
<td>Moves the active cell to the last column with data in the current row</td>
</tr>
<tr>
<td>Ctrl+Page Down</td>
<td>Moves to the next worksheet</td>
</tr>
<tr>
<td>Ctrl+Page Up</td>
<td>Moves to the previous worksheet</td>
</tr>
<tr>
<td>F5</td>
<td>Opens the Go To dialog box</td>
</tr>
</tbody>
</table>
Section 2

Data Entry and Revision

When entering data into a worksheet, a cell must first be selected.

- Use the mouse, or keyboard to select the *active cell*, designated by the bold outline.
  - Clicking the cell once will select and activate it.
  - Double-clicking the cell will cause the *cursor* to appear.

Once the active cell has been selected, just start typing.

- While the cell is active, you can use the *Backspace* key to edit the data you’re typing.

After your finished typing the data into the cell, press either the *Enter* key or the *Tab* key to “enter” the data and to move onto the next cell.

If you want to confine the cell movement to a specific range, you can highlight that range and then use the *Enter* key or *Tab* key to move through the selected cells

- The cell selection will wrap within the range.
- If you use the arrow keys, your range will be deselected.

When *editing* data that is already entered, you can:

1. Select (single click) the cell and retype the information (the previous contents of the cell will be replaced).

2. Select (single click) the cell and press F2, which will place the *cursor* at the end of the contents of the cell, and then modify the contents (using the left and right arrow keys, the *Home*, the *End*, the *Backspace*, or the *Delete* key).

3. Double-click the cell to place the cursor at the point of interest, and modify the contents.

4. Select (single click) the cell and go the the *Formula bar*, which displays the contents of the active cell, to modify the contents.
2.1 Cut, Copy, and Paste

The cut, copy, and paste editing tools are available in Microsoft Excel, just as they are available in Microsoft Word.

- Can access them either through the Edit drop menu, using the Standard Toolbar buttons, or by using their associated keyboard shortcuts:

<table>
<thead>
<tr>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+X</td>
<td>Cut</td>
</tr>
<tr>
<td>Ctrl+C</td>
<td>Copy</td>
</tr>
<tr>
<td>Ctrl+V</td>
<td>Paste</td>
</tr>
</tbody>
</table>

Can also use the drag-and-drop method:

1. Select the cells you wish to move.
2. Point to an outside border of the cell.
3. Click and drag the cell(s) to the new location.

With the drag-and-drop method, the data is removed from its original location and **overwrites** the contents in the destination location, just as when you cut and paste.

2.2 Find and Replace

Using Find or Replace from the Edit drop menu allows you to quickly find and/or replace text or numbers in multiple cells.

1. Select the range of cells you want to search.
   - If you want to search the entire worksheet, click any cell in the worksheet.
2. If you wish to only search but not replace, select Find from the Edit drop menu.
   - Can also use the Ctrl+F keyboard shortcut.
   - In the Find what: box, enter the text or numbers you want to search for or choose a recent search from the Find what: drop down box.
   - Click Options to further define your search.
     - In the Within box, you can select Sheet or Workbook to search a worksheet or an entire workbook.
   - To find the highlighted occurrence or all occurrences of the specified characters, click Find All or Find Next.
3. If you wish to search and replace, you can either select Replace from the Edit drop menu (Ctrl+H keyboard shortcut) or you can select the Replace tab if the Find and Replace dialog box is already open.
   - In the Find what: box, Enter the text or numbers to find in the Find what: box as described.
   - In the Replace with: box, enter the replacement characters and specific formats if necessary.
     - If you want to delete the characters in the Find what: box, leave the Replace with: box blank.
   - Click Options to further define your search.
   - To replace the highlighted occurrence or all occurrences of the found characters, click Replace or Replace All.
2.3 Filling Data

The Autofill feature allows you to quickly fill in commonly used series of data, such as repetitive or sequential data.

- Often used to fill in chronological dates or numbers, or repeated text.
- Example: If a cell contains the word "January", can quickly fill in other cells with "February", "March", etc.

To use the Autofill feature:

1. In several cells, type the first few elements of the series in order for Autofill to distinguish the pattern.
   - Example: Type 1, 3, and 5 into three different cells.
   - You can also incorporate blank cells into your pattern.
2. Highlight the cells distinguishing the series.
3. Select the handle at the bottom right corner of the cell with the left mouse and drag it down across as many rows as you want to fill.
   - Can also autofill across columns by dragging right.
4. Release the mouse button.

If you want to autofill a column or row with cells displaying the same number or text often you only need to enter the data to repeat in one cell. Highlight this one cell and drag the handle of the selection with the mouse.

- If Excel does not distinguish the repeating patterns, enter the same data into two adjacent cells, highlight the two cells, and then drag the handle of the selection with the mouse.

2.4 Sorting Data

To execute a basic descending sort based on one column:

1. Highlight the cells, rows, or columns that will be sorted.
2. Select Sort from the Data drop menu.
3. From the Sort dialog box, select the column for sorting from the Sort By drop-down menu and choose either ascending or descending.

NOTE: If you want to sort your whole data set by one column, highlight your whole data set before sorting. If you highlight only the column you wish to sort, the one column will be sorted, but the remainder of the corresponding data will not.

If the cells you highlighted include the text headings in the first row, mark My list has... Header row in the Sort dialog box and the first row will remain at the top of the worksheet.

Click the Options button in the Sort dialog box for special non-alphabetic or numeric sorts such as months of the year. The Options button also allows you to sort rows (i.e., Sort left to right instead of Sort top to bottom).
Section 3

Formatting Cells

The contents of a highlighted cell (either numbers or text) can be formatted in many ways.

By default all cells are in General format where text is left-aligned (contents of cell are flush with the left border of the cell) and numbers are right-aligned (contents of cell are flush with the right border of the cell).

3.1 Format Cells dialog box

The Format Cells dialog box contains a complete list of formatting options.

- Highlight the cells you wish to format first and then open the Format Cells dialog box by one of several ways:
  - Select Format cells from the Format drop menu.
  - Right-click on the highlighted cells and choose Format Cells from the shortcut menu.
  - Use the Ctrl+1 keyboard shortcut.

The formatting options are contained in several tabs:

- The Number tab allows you to specify the data type of the contents of the cell.
  - Select General from the Category box if the cell contains text and number.
  - Use Number if you want to round your numeric values to a particular number of decimal places.
  - If you enter the date January 1, 2001 into a cell on the worksheet, Excel will automatically recognize the text as a date and change the format to 1-Jan-01. To change the date format, select Date from the Category box and choose the format for the date from the Type box.
  - If the field is a time, select Time from the Category box and select the type in the Type box.
  - Date and time combinations are also listed.
  - When you have numbers with leading zeros, Excel usually drops them, but formatting the cells as Text will keep them.
  - Select Special if your cells contain zip codes, phone numbers, or Social Security numbers.

- The Alignment tab allows you to change the position and alignment of the data within the cell.
  - You can also wrap text within a cell, and merge cells in the Alignment tab.

- The Font tab allows you to change all of the font attributes including font face, size, styles, and effects.

- The Border and Pattern tabs allow you to add borders, shading, and background colors to a cell.
3.2 Autoformat

Autoformat from the Format drop menu also has many preset table formatting options.

1. Highlight the cells you wish to be formatted.
2. Select Format from the Autoformat drop menu.
3. Select from the list to find the most appropriate formatting.
4. Click the Options... button to select the elements that the formatting will apply to.
5. Click OK when finished.

3.3 Format Painter

A handy feature on the standard toolbar for formatting text is the Format Painter. Specifically, it is useful when you have formatted a cell with a certain font style, date format, border, and other formatting options, and you want to format another cell or group of cells the same way.

1. Place the cursor within the cell containing the formatting you want to copy.
2. Click the Format Painter button in the standard toolbar (notice that your pointer now has a paintbrush beside it).
3. Highlight the cells you want to add the same formatting to.

3.4 Formatting Toolbar

The shortcut buttons on the Formatting Toolbar can also be used to adjust the font and cell attributes, including the font face, size, style (bold, italic, and/or underlined), the alignment of the data within the cell, and the data type.

If this toolbar is not already visible on the screen, select Formatting from Toolbars from the View drop menu.

The following formatting keyboard shortcuts can also be used:

<table>
<thead>
<tr>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+B</td>
<td>Bold</td>
</tr>
<tr>
<td>Ctrl+I</td>
<td>Italicize</td>
</tr>
<tr>
<td>Ctrl+U</td>
<td>Underline</td>
</tr>
<tr>
<td>Ctrl+5</td>
<td>Strikethrough</td>
</tr>
<tr>
<td>Shift+Ctrl+$</td>
<td>Format as currency with 2 decimal places</td>
</tr>
<tr>
<td>Shift+Ctrl+%</td>
<td>Format as percent with no decimal places</td>
</tr>
</tbody>
</table>

3.5 Conditional Formatting

Conditional Formatting allows you to define and apply formatting to some cells, text, and numbers based on criteria that you set.

- **EXAMPLE:** Use Conditional Formatting to highlight all cells in any given range that are greater than 100.

- The formatting, such as cell shading or font color, is automatically applied to the cells for which the specified condition is true.

To add a conditional format:
1. Select the cells for which you want to add the conditional formatting.

2. Select Conditional Formatting from the Format drop menu.

3. Do one of the following:
   (a) **To use values in the selected cells as the formatting criteria**, click Cell Value Is, select the comparison phrase, and then type a constant value or a formula. If you enter a formula, start it with an equal sign (=).
      - **EXAMPLE:** Use conditional formatting to highlight all ages \( \geq 25 \). Choose greater than or equal to as the comparison phrase, and then type 25 as the constant.
   (b) **To use a formula as the formatting criteria (to evaluate data or a condition other than the values in selected cells)**, click Formula Is and then enter the formula that evaluates to a logical value of TRUE or FALSE.
      - Formulas are discussed in detail in the other lectures.
      - **EXAMPLE:** Use conditional formatting and the COUNTIF function to find duplicate values of Baseline HR. Set up the conditional format for the first baseline HR (in cell F2) using the formula \( \text{=COUNTIF(F:F, F2)} > 1 \), and then use the Format Painter (see below) to copy the formula to the other cells of interest.

4. Click Format.

5. Select the formatting you want to apply when the cell value meets the condition or the formula returns the value TRUE.

6. To add another condition, click Add, and then repeat steps 1 through 3.
   - You can specify up to three conditions. If none of the specified conditions are true, the cells keep their existing format.
   - If more than one specified condition is true, Microsoft Excel applies only the formats of the first true condition, even if more than one condition is true.

To copy formats to other cells:
1. Select the cells that the conditional formats you want to copy.
2. On the Formatting toolbar, click Format Painter (to the right of Paste), and then click the cells you want to format.

To change or remove a conditional format:
1. Do one or more of the following from within the Conditional Formatting dialog box:
   (a) To change formats, click Format for the condition you want to change and change appropriately.
   (b) To reselect formats on the current tab of the Format Cells dialog box, click Clear.
   (c) To remove one or more conditions, click Delete, and then select the check box for the conditions you want to delete.
      -> To remove all conditional formats as well as other cell formats for selected cells, point to Clear on the Edit menu, and then click Formats.

To find cells that have conditional formats:
1. To find all cells that have conditional formatting, click any cell.
   To find cells that have conditional formatting settings identical to the settings of a specified cell, click the specific cell.
2. On the Edit menu, click Go To.

3. Click Special.

4. Click Conditional formats.

5. Do one of the following:
   (a) To find cells with any conditional formatting, click All below Data validation.
   (b) To find cells with identical conditional formats, click Same below Data validation.

### 3.6 Styles

The use of styles in Excel allow you to quickly format your worksheet, provide consistency, and create a professional look.

Excel provides several preset styles in the Style dialog box:

1. Highlight the cell(s) you want to add a style to.
2. Select Style... from the Format drop menu.
3. Select the desired style from the Style name: drop-down box.
   - **Comma** adds commas to the number and two digits beyond a decimal point.
   - **Comma [0]** is the Comma style that rounds to a whole number.
   - **Currency** formats the number as currency with a dollar sign, commas, and two digits beyond the decimal point.
   - **Currency [0]** is the Currency style that rounds to a whole number.
   - **Normal** reverts any changes to general number format.
   - **Percent** changes the number to a percent and adds a percent sign.

You can also create your own styles by modifying any of the pre-defined styles in the Style dialog box.

1. Highlight the cell(s) you want to add a style to.
2. Select Style... from the Format drop menu.
3. Select the desired style from the Style name: drop-down box.
4. Modify the attributes by clicking the Modify button.
5. Check all the items under Style includes that the style should format.
6. Click Add to preview the formatting changes on the worksheet.

You can also rename any existing style:

1. Select the cell on the worksheet containing the formatting you would like to set as a new style.
2. Select Style... from the Format drop menu.
3. Click the Style name: box so the style name is highlighted.
4. Delete the text in the Style name: box and type the name of the new style.
5. Press OK when finished.
Section 4

Other Useful Skills

4.1 Additional Keyboard Shortcuts

The following are some of many document action keyboard shortcuts:

<table>
<thead>
<tr>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+O</td>
<td>Open an existing file</td>
</tr>
<tr>
<td>Ctrl+N</td>
<td>Open a new file</td>
</tr>
<tr>
<td>F12</td>
<td>Save As</td>
</tr>
<tr>
<td>Ctrl+S</td>
<td>Save</td>
</tr>
<tr>
<td>Ctrl+P</td>
<td>Print</td>
</tr>
<tr>
<td>Ctrl+Z</td>
<td>Undo</td>
</tr>
<tr>
<td>Ctrl+Y</td>
<td>Redo</td>
</tr>
</tbody>
</table>

4.2 Worksheet Modification

To add a row to a worksheet: select Rows from the Insert drop menu, OR highlight the row(s) by clicking on the row label(s), right-click with the mouse, and choose Insert.

- The row(s) will be inserted above.

- To delete a row from a worksheet: highlight the row(s) by clicking on the row label(s), and select Delete cells from the Edit drop menu, OR, right-click with the mouse, and choose Delete.

To add a column to a worksheet: select Columns from the Insert drop menu, OR highlight the column(s) by clicking on the column label(s), right-click with the mouse, and choose Insert.

- The column(s) will be inserted to the left.

- To delete a column from a worksheet: highlight the column(s) by clicking on the column label(s), and select Delete cells from the Edit drop menu, OR , right-click with the mouse, and choose Delete.

There are two ways to resize rows and columns:

1. Resize a row by dragging the line below the label of the row you would like to resize. Similarly, drag the line to the right of the label of the column you would like to resize.

2. Click the row or column label and select Height by pointing to Row from the Format drop menu or Column from Width from the Format drop menu to enter a numerical value for the height of the row and width of the column.
When the data in the cell is too long to be displayed, you will see pound signs (#) in the cell.

- You can change the column width by dragging.
- You can also use the *AutoFit* function to adjust the column width to accommodate the longest entry by double-clicking on the right column divider line of the desired column.
- Can also use this method to shrink a specific column to optimal width.
- Can also use this method to expand/shrink all columns with text in a worksheet to optimal width.
  - Highlight all of the columns in the worksheet.
  - Double-click on the right column divider line of any of the highlighted columns.

When you have a large worksheet with column and row headings, you can use the **Freeze Panes** feature such that the headings can be visible at all times, even as the worksheet is scrolled.

- Click the label of the row below the row that should remain frozen at the top of the worksheet.
- Select **Freeze Panes** from **Window** drop menu.
- To remove the frozen panes, select **Unfreeze Panes** from the **Window** drop menu.
- A similar process can be done to freeze a column (click the label of the column to the right of the column that should remain frozen at the left of the worksheet).
- You can also *split the screen* on both rows and columns.

**To insert a worksheet:** select **Worksheet** from the **Insert** drop menu, *OR* right-click a worksheet tab and choose **Insert**.

- **To delete a worksheet:** select the sheet by clicking the appropriate worksheet tab, and then select **Delete** from **Sheet** from the **Edit** drop menu, *OR* right-click the worksheet tab and choose **Delete**.

**To rename a worksheet:** select **Rename** from **Sheet** from the **Format** drop menu, *OR* right-click the worksheet tab and choose **Rename**.

**To move a worksheet:** select **Move/Copy** from **Sheet** from the **Edit** drop menu, *OR* click and drag the worksheet tab to the desired position.

- **Move/Copy** from **Sheet** from the **Edit** drop menu can also be used to *copy* the worksheet.

### 4.3 Page Properties and Printing

**To set page breaks** within the worksheet:

- Select the row you want to appear just below the page break by clicking the row’s label.
- Then choose **Page Break** from the **Insert** drop menu.
- You can also use **Page Break Preview** from the **View** drop menu to manually override page breaks.

Select **Page Setup** from the **File** drop menu to format the page, set margins, and add headers and footers. Like the **Format Cells** dialog box, the **Page Setup** dialog box has several tabs:
Select the Orientation under the Page tab to make the page Landscape or Portrait. The size of the worksheet on the page can also be formatted under Scaling. To force a worksheet to print only one page wide so all the columns appear on the same page, select Fit to 1 page(s) wide by 1 tall.

Change the top, bottom, left, and right margins under the Margins tab. Enter values in the header and footer fields to indicate how far from the edge of the page this text should appear. Check the boxes for centering horizontally or vertically on the page.

Add preset headers and footers to the page by clicking the drop-down menus under the Header/Footer tab. To modify a preset header or footer, or to make your own, click the Custom Header and Custom Footer buttons. A new window will open allowing you to enter text in the left, center, or right on the page.

- Format Text - Click this button after highlighting the text to change the font, size, and style.
- Page Number - Insert the page number of each page.
- Total Number of Pages - Use this feature along with the page number to create strings such as "page 1 of 15".
- Date - Add the current date.
- Time - Add the current time.
- File Name - Add the name of the workbook file.
- Tab Name - Add the name of the worksheet’s tab.

On the Sheet tab, check Gridlines if you want the gridlines dividing the cells to be printed on the page. If the worksheet is several pages long and only the first page includes titles for the columns, select Rows to repeat at top to choose a title row that will be printed at the top of each page (or Columns to repeat at left).

Select Print Preview from the File drop menu to view how the worksheet will print.

- Click the Next and Previous buttons at the top of the window to display the pages.
- Click the Zoom button to view the pages closer.
- Make page layout modifications needed by clicking the Page Setup button.
- Click Close to return to the worksheet or Print to continue printing.

To print the worksheet, select Print from the File drop menu.

- Print Range - Select either all pages or a range of pages to print.
- Print What - Select selection of cells highlighted on the worksheet, the active worksheet, or all the worksheets in the entire workbook.
- Copies - Choose the number of copies that should be printed.
- Check the Collate box if the pages should remain in order.

## 4.4 Data Import and Export

The file(s) you wish to work with may not always be in the form of a Microsoft Excel file. Fortunately, it is quite easy to both open non-Microsoft Excel files and save your Microsoft Excel files as another file format.
4.4.1 Importing Data

By importing data, you don’t have to retype the data you want to analyze in Microsoft Excel.

You can import data

1. from databases and files, such as text files (.txt), and comma-delimited files (.csv)
2. with Microsoft Query
3. from the Web
4. with Visual Basic for Application VBA

You can import data to Microsoft Excel from most data sources by pointing to Import External Data on the Data menu, clicking Import Data, and then choosing the data you want to import in the Select Data Source dialog box.

You can also convert a file from another program to Microsoft Excel by opening it in Excel with the Open command (File menu), such as text files (.txt) and comma-delimited files (.csv).

The Data Connection Wizard, available when you click New Source in the Select Data Source dialog box, makes it possible to import data from external data connections not available from the Select Data Source dialog box.

To import a text file:

EXAMPLE: Use the samplefile.txt (a space-delimited file) to practice importing a file.

1. Open a new Microsoft Excel spreadsheet, move to a blank spreadsheet, or click the cell where you want to put the data from the text file.
2. On the Data menu, point to Import External Data, and then click Import Data.
3. In the Files of type box, click Text files.
4. In the Look in list, locate and double-click the text file you want to import.
5. To specify how you want to divide the text into columns, follow the instructions in the Text Import Wizard, and then click Finish.
6. In the Import Data dialog box, click Properties to set formatting and layout options for the imported data.
7. In the Import Data dialog box, do one of the following:
   (a) To return the data to the location you selected (or cell A1 in a new/blank spreadsheet), click Existing worksheet, and then click OK.
   (b) To return the data to a new worksheet, click New worksheet, and then click OK. Microsoft Excel adds a new worksheet to your workbook and automatically puts the imported data in the upper-left corner of the new worksheet (starting in cell A1).

To import the file using the Open command (File menu), choose All Files (*.*) from the Files of type: drop box. Then just work your way through the Text Import Wizard.
4.4.2 Exporting Data

You can convert a file from Microsoft Excel to another file format by saving it with the **Save As** command (File menu) in Excel.

- Use the **Save as type**: drop box to choose the desired file format.
- The file formats available in the **Save As** dialog box vary, depending what type of sheet is active (a worksheet, chart sheet, or other type of sheet).
- For most file formats, Excel converts only the active sheet.
- To convert the other sheets, switch to each sheet and save it separately.
- You can save (and open) files in many formats including
  1. *Microsoft Excel formats*
  2. *text formats*, such as formatted text (.prn), tab-delimited text (.txt), and comma-delimited text (.csv)
  3. *other spreadsheet and database formats*
  4. *clipboard formats*

--- **EXAMPLE:** Save the hrdata.xls file as a comma-delimited (.csv) file using **Save As**.

4.5 Customizing Excel

4.5.1 Menus

Unlike previous versions of Excel, the menus in Excel 2000 initially list only the commands you have recently used. To view all options in each menu, click the double arrows at the bottom of the menu.

If you would like to revert to the way older versions of Excel displayed menu options, follow these steps:

1. Select **Customize** from **Toolbars** from the View drop menu.
2. Click on the **Options** tab.
3. Uncheck the “Menus show recently used commands” first check box (or something similar).

4.5.2 Toolbars

Many toolbars displaying shortcut buttons are available. Select **Toolbars** from the View drop menu to select more toolbars.

Customizing toolbars allows you to delete certain shortcut buttons from a toolbar if you do not use them and add the shortcut buttons for commands you use often.

1. Select **Customize** from **Toolbars** from the View drop menu and select the **Commands** tab.
2. By clicking on the command categories in the **Categories** box, the commands will change in the **Commands** box to the right.
3. Select the command you would like to add to the toolbar by selecting it from the **Commands** box.
4. Drag the command with the mouse to the desired location on the toolbar and release the mouse button. The shortcut button should now appear on the toolbar.
5. Remove buttons from the toolbars by reversing these steps. Highlight the button on the toolbar, drag it off the toolbar with the mouse, and release the mouse button.